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Preface 
This document outlines the steps required to test a specific application, as a step towards achieving 

VMware Ready status for that product.  Its assumed that a VMware partner will be leading this testing, 

and that they are already a member of TAP, the Technical Alliance Program at VMware.  General 

program guidelines for TAP and VMware are largely on-line, and outside of the scope of this document.   

VMware Ready status helps identify products that have been specifically tested for use on VMware 

platforms, and as such provide added confidence to customers who are considering adopting those 

applications.  However, the scope of such testing is limited by practical considerations, and the logo is no 

guarantee of functionality or performance, and it is recommended that vendors of VMware Ready 

applications perform rigorous performance and QA testing on VMware platforms, as they would before 

releasing their product on other platforms.   

Summary 
The following testing process focuses on how to get an application into a vCloud Air environment, how 

to make it externally accessible in that vCloud Air environment, and how to do load testing against the 

application in that environment.  As such, it is assumed that the vendor performing is using a product 

that is generally available today, supported on vSphere deployments.  It is also assumed that the vendor 

has basic hands-on skills with both vSphere and the vCloud Suite.  Having engineers that are certified on 

these products is recommended.   

This testing will include a simple load testing step, to ensure that the sizing and configuration of the 

application is reasonable for use in a vCloud Air configuration.  We therefore assume the tester will have 

access to a load driver that drives load that is similar to what a real user might do with the product. In 

some cases this load driver could be a simple script or command line that initiates a batch operation, but 

more likely it will be based on a tool that allows simulation of on-line users, such as HP LoadRunner or 

the open source tool JMeter.  Construction of new load tests is a labor intensive effort, and is outside of 

the scope of this testing, but it is assumed that vendors would already have a load driver to ensure they 

understand the performance of their products before they release them.   

A vCloud Air environment will be provided to the tester for a short period (known as the on-line testing 

phase), during which the testing outlined below will be completed.  Getting access to a vCloud Air 

environment for a longer period may be useful for a vendor interested in this program, but that is 

outside of the scope of this testing process – the below testing will take place within a 2 or 3 hour period 

on a loaner vCloud Air configuration that will be provided.  At the completion of this testing cycle, it will 

be determined if the testing was a success or not, and if not, specific recommendations will be made to 

the partner on what to improve before the next testing attempt.  After 3 such testing cycles, if the 

product is still not passing the tests, then testing will be assumed complete and the application will not 

have achieved the VMware Ready logo.  

The general process of certification is a follows: 



 

1. Partner creates appropriate vApp of the application to be tested, and provides it to the 

certification team (existing vApps may also be used) 

2. Certification team and partner meet on via on-line collaboration tools (e.g. webex) to perform 

on-line testing phase. 

3. Certification team and partner collaborate to deploy and license application from the vCloud Air 

service catalog, and then make it externally accessible by setting up appropriate networking and 

firewall configuration. 

4. Partner drives load against deployed application and certification team gathers metrics to 

understand the capacity and performance of the vApp. 

5. Certification team determines if the certification was successful and notifies partner.  

 

Prerequisites  
 

The minimum prerequisites for this testing are as follows: 1) a stable product that is in general 

availability and that is current supported to be run on vSphere, 2) a load driver or batch load that can 

drive the product to a reasonable CPU utilization, and that simulates a typical use of the product in 

production use, 3) TAP membership for the partner submitting the application for VMware Ready status 

for the application.   It is also highly recommended that the vendor of the application have staff that has 

appropriate VMware certifications, such as VMware Certified Professional status.  The tester will need 

to create a vApp or Virtual Appliance for the application under test (note: we use the terms vApp and 

Virtual Appliance interchangeably in this document, but generally a Virtual Appliance is one VM, which a 

vApp contains multiple VMs).  Once the certification team has access to this virtual appliance, the on-

line portion of the certification testing can take place.   

vApp Creation, Upload and Deployment 
 

The following sections provide guidance on how to create your vApp, how to upload it into a vCloud Air 

environment, and how to deploy it and configure it in that environment.  It is the testers’ responsibility 

to build such a vApp before the on-line certification process begins, as per the directions below.  If the 

tester already has such a vApp, they may simply provide that for the on-line testing, but they should 

ensure that the below checklist is adhered to for that vApp.  A vApp template uploaded to vCloud Air’s 

service catalog is a definition of the applications virtual machine requirements, a snapshot of the default 

vanilla state of the application upon deployment and additional installers or configuration files to help 

the application run post deployment procedures in cloud. 

vCloud Air uses OVF/OVA as its primary standard for upload of vApp templates in the service catalog. 

Below are some of the key points/checklist to remember while building a vApp/Virtual machine 



 

template. There are multiple ways to create a vApp template, however creating templates using vCenter 

server is suggested. 

Checklist for building virtual machine templates: 

1. The template must be in OVF/OVA format and should not have any residue IP/MAC addresses or 

static configuration attached to it. Using ‘convert to template’ feature in vCenter server ensures 

the static configuration content is overwritten 

2. Create a virtual machine with default reservation, shares and limits 
3. Use hardware version 7, 8 or 9 while building the virtual machine template. If using vCenter 

server 5.x and above the virtual machine template is automatically set to the highest hardware 

version available 

4. Install latest VMware tools  

5. Check if the Virtual Appliance’s operating System is listed in the supported OS list, the current 

list is here,  http://pubs.vmware.com/guestnotes/ 

Creating Virtual machine template using vCenter server 

Using vCenter server to creation your vApp or Virtual machine is the recommended approach, as it 

doesn’t require larger install steps such as vCloud Director.  However, existing vApps created through 

other mechanisms (e.g. VMware Studio or vCloud Director) may also be acceptable, if they fit the 

specified criteria.   

1. Log in to vCenter Server, version 5.x , select a cluster/datacenter, Click File->New->vApp 

 

 

 

2. Give it a recognizable name, this will be the name that will be used in vCloud Air service catalog, 

please name it appropriately. 

 

 



 

 

3. On the resource Allocation tab, leave the resources to Normal shares with no reservation or 

Limits applied. These sections are overwritten during vApp upload on vCloud Air  



 

 



 

4. Confirm selections and Click Finish

 



 

5. Right click the newly created vApp from the inventory list, click add a virtual machine

 



 

6. Create new Virtual Machine window pops up, select, ‘Typical’ radio button for configuration

 
7. Give the Virtual machine Name, the name of the virtual machine should be meaning full, since 

the virtual machines created using this template will also follow the naming convention 

mentioned here. Add Storage information, The OS, Network and click complete, if ready.  While 

selecting Network, Please use ‘VMXNET3’. Add disk information according to your vApp 

requirements. 



 

8. 



 



 

 



 

 



 

 
9. At this point, the first virtual machine for the Virtual applinace has been defined, if your 

application needs more virtual machined to be added please repeat the procedure to add a new 

virtual machine to the vApp. Else power ON the vApp, connect the Operating System ISO via 

USB/host ISO and proceed to install the OS and application 



 

 

 
10. After the OS and application had been installed, go ahead and install VMware Tools , hot to 

install VMware tools: 

https://www.vmware.com/support/ws55/doc/ws_newguest_tools_linux.html#wp1127214 



 

 



 

 

 
11. Configure Custom OVF properties: 

a. In case you would like to identify an custom OVF properties, add it after powering off 

the vApp, start orders etc. 



 

  



 

12. Export the vApp Template,  Select the vApp, File -> Export , click OVA as the format 

  

 

Uploading vApp template in vCloud Air service catalog  
 

The Partner will upload the vApp based on the upload instructions provided by the certification team, 

the certification team will upload the vApp template into the service catalog using the below steps. 



 

Login to your vCloud Air Public cloud instance with the user credential provided to you, https://vCloud 

Air.vcloud .com, upon landing on the dash board, select US-Nevada as your Cloud region  from the drop 

down list on the top of the page

 



 

13. Once on the Dashboard for the US-Nevada region,  select the virtual data given 

 
14. The Virtual Datacenter Dashboard is displayed, we want to add the vAPP catalog here, click on 

‘Manage Catalogs in vCloud Director’ 

 



 

15. A new window/tab displaying vCloud Director’s user interface with Organization Catalogs is 

displayed, select the catalog by name ‘VMR’ 

 
 

16. Once inside the VMR catalog in vCloud Director, click the upload button to locate the vApp OVA 

on your local system and upload it, if this is the first time uploading a vApp to vCloud director’s 

interface, you will be prompted to downlaod and install the ‘Client Integration Plugin’. 

 



 

 

 



 

  



 

 



 

 

 
 

17. The upload begins, the upload time may vary based on the size of the vApp 

 



 

 

 

 



 

 

 

Adding Virtual machines from service catalog 
 

 

Below section showcases in general steps to deploy a Virtual Machine/ vApp from a service catalog into 

active Cloud and also how to edit/change Firewall and Routing properties to enable traffic from external 

sites to reach your application in the Cloud.  These steps will be executed by the tester and the 

certification team during the on-line testing phase, so the following is for information only.   

 

The sample virtual machine template used in the steps below is CentOS that was created using the 

above methods and has light-http service running on it (web server). The goal is to deploy the centos 

template from the service catalog and have it configured to have the web server accessible from any 

external network. 

 

Deploying Virtual machines 
 

1. Login to vCloud Air portal and click on the vDC where a new centos virtual machine with 

webserver needs to be deployed.  



 

 

2. Click on the Virtual Machines tab and click ‘Add One’. The virtual machine view gives you a list of 

virtual machines that are currently added to the cloud.

 
3.   A popup screen with a list of Catalogs appears, the catalog has two tabs, VMware Catalog and 

‘My Catalog’. The VMware Catalog has images that are publicly available to all service 



 

subscribers of vCloud Air. These are vanilla OS templates. The ‘My Catalog’ is where vApp 

templates uploaded by a user will be listed. Click on this tab to select a virtual machine 

template, select the template by clicking the Radio Button against it and click Continue.



 



 

 
4. Next up, questions on the name to be given to this machine in the Cloud, networking and 

resource allocation will be asked. Give the virtual machine a name, click the radio button “Select 

network manually’. We can choose to add more disk space to the virtual machine that the one 

listed. However, the additional disk space will only be visible after the disk has been 



 

appropriately mounted on Power on.

 
5. The next screen takes us over selecting the appropriate network to place the vApp into. By 

default a vDC will have two types of networks, an Isolated network, which is not accessible from 

any external interfaces, and a Routed network, which can be configured ( with appropriate 

firewall policies and NAT rules) to be accessible from external networks.  If the virtual machine 

you are deploying needs to be visible to external world, always place it in a Routed Network. In 

the example to follow, we want the webserver on the CentOS template to be visible, hence 

placing it in a Routed Org Network. Select the network, and click ‘Deploy This virtual machine’. 



 

 
6. The virtual machine gets deployed . Click on ‘Power On’ to start the machine. At this point the 

virtual machine has been deployed in cloud and is ready



 



 

 

 

Licensing Appliance 
 

The virtual appliances that will be eventually uploaded to the service catalog will be listed in VMware 

marketplace (VSX). Since the appliance resides in a public domain and if the appliance needs a license, 

there has to be processes/mechanisms defined to deliver the License pre/post deployment. 

There are multiple ways to deliver a license to ‘activate’ the application. The appliance can have 

Evaluation license already wired into the vApp template and a valid license can be delivered/applied 

post deployment upon purchase, Or, if the license isn’t already wired and the vApp needs it upon 

deployment, an evaluation license can be published along with the user guide for the appliance.  

Configuring deployed VM for external access. 
 

  The Routed Org networks in vCloud Air are virtual private networks that by default do not allow any 

packets of data through and from the network to any outside or other private networks in the vDC, they 



 

are protected by a Firewall. These networks can be customized such that only application level traffic 

can be exposed to external networks. Since we placed our virtual machines in this network and we want 

only the application specific traffic (web traffic in this case) to flow through the networks, we can 

append/customize Firewall/NAT rules to enable this. Below steps show how the IP address of the virtual 

machine which is a private non routable address on the internet is mapped to a Public Routable address 

to achieve traffic flow.  

In order to map the private IP address to Public IP’s, there needs to be Public IP address available in the 

vDC. A single Public IP can be mapped to multiple private IP’s on a port basis, however if the mappings 

are done on all inbound TCP/UDP ports than Public IP ‘s needed will be equal to the private IP’s mapped. 

 

 

1. To begin configuring Firewall rules, first we need to identify the Private IP address of the virtual 

machine deployed, you can get this information by logging into your vDC and clicking on 

‘Manage VM in vCloud Director’. This opens up the native vCloud Director interface. 

 
2. Once in the vCloud Director interface, Click on Virtual machines tab and note the IP address of 

the virtual machine. For this example, the virtual machine, VMR-test-vapp has a IP of 

192.168.109.5 



 

 

 

3. Looking at the console , there is a web server active on port 5480 of the virtual machine, 

Pointing the browser window to the https://192.168.109.5:5480 will not lead us to any site , 

https://192.168.109.5:5480/


 

since it’s a non-routable address. 

 
4. To change the network configuration, to allow inbound traffic on port 5480 to the virtual 

machine, we need to to append the Firewall and NAT( network address Translation) settings. 

Login to the vDC, click on the gateways tab. Double click the gateway listed to reach to the 



 

configuration page.

 

 

5. On the NAT tab, there will be two rules defined; one is a SNAT rule that will allow traffic that is 

out bound from the virtual machine to the outside/external networks and a DNAT rule that will 

allow incoming traffic from the outside world to this particular virtual machine via the Public IP 

address “192.240.153.42”. 

 

Click on ‘Add one’ , add a SNAT and a DNAT rules to allow all inbound and outbound ports from private 

IP ‘192.168.109.5’ to public IP ‘192.204.153.42’ 

 



 

 

6. The NAT rules helps us map the IP’s together, however Firewall still needs to enable to allow 

specific traffic between these two networks. On the same page in the vDC, click on the Firewall 

tab. We will allow any inbound packet from external network on port 5480 to the private 

network. Also for the reverse traffic allow any outbound packet from internal network on port 

5480 to outside/external networks on TCP and UDP. 



 

 

7. This completes the IP mappings and firewall changes, now if you point the browser to the 

external IP address @ port 5480 you will reach the virtual machines web page, see below.   

  



 

 

 

 

 

 

  

  



 

Driving Load against the deployed vApp: 
 

The next step for the certification process involves testing the application connectivity and performance 

by driving load across the WAN using the public IP address configured for the vApp.  It is recommended 

to use the same tools being used for existing Physical / Virtual testing, and that the load driver will drive 

load from an on-premise configuration, across the WAN to the vCloud Air setup where your application 

is running. 

Once the vApp has been successfully deployed and configured for external access, configure your load 

generator (LoadRunner, JMeter or in-house tools, etc.) to drive application load through the public IP 

address. Collect the in-guest resource utilization numbers during the test runs using vCloud Air portals’s 

VM console.  Use the Load generator results and correlate with VM resource utilization for the vApp. 

As an example, the steps for Load testing using JMeter have been listed below. 

Load Testing using JMeter 2.11 

 

JMeter is a Java based application designed to load test and measure performance of various application 

resources (like Files, Web dynamic languages - PHP, Java, ASP.NET, etc.). Below mentioned steps 

highlight how JMeter can be used to simulate heavy Web traffic load on a lighthttpd server deployed on 

vCloud Air Cloud. 

Prerequisites: 

a. Confirm the Web Server is accessible externally using an IP address/hostname. 

b. Latest versions of JMeter and Java are installed on the desktop being used for testing. 

c. List information regarding 3-4 Webpages that can be used to serve the http/https 

requests generated by JMeter. The Webpages can be different links within the Website. 

Steps to generate load using JMeter: 

1. Create a Test Plan with 2 -3 Thread Groups and HTTP requests as shown below. For all the 

Thread groups, select the number of threads, ramp up time and loop count.  



 

 
 

2. Enter the Web server IP, port number and path of the website. Change the protocol to https, if 

required. 

 



 

3. Add the “View Results in Table” and “Graph Result” tabs (Test Plan -> Add -> Listner) 

4. Once the configuration is finished, Press Start button to start the test: 

 
 

Graph: 



 

 
 

 

 

5. Open vCloud Air.vmware.com, go to the VM (Webserver) detail page and click monitoring. 

Check the resource Utilization numbers for the VM. There should be a increase in the CPU 

utilization during the JMeter test execution.  Ideally the amount of CPU utilization from the load 

test is typical of real production use, so between 10% CPU and 60% CPU.   



 

 

6. Open the VM console by clicking the “Launch Console” button through the vCloud Air portal.  

7. Use the top command to observe the increase in CPU utilization during the tests. 



 

 
 

8. Use the “netstat –atc” command to observe the network traffic and queuing during the tests. 

 

 


